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1. Introduction 
 

What is Climsoft? 

The Climsoft system is a suite of software which is specifically designed for storing climatic data 
in a secure and flexible manner, and for obtaining useful information using these data. Climsoft 
version 4 was developed using Microsoft Visual Basic.NET. The default database storage 
engine is the open source MariaDB which is a fork from MySQL. 

The Climsoft system comprises: 

 The database, which holds climatic data for multiple stations in a logical and flexible 
structure;  

 A Key-entry component, to allow users to add new data to the database in a secure and 
controlled manner; 

 Facilities for importing climatic data in various formats into the database e.g. Data from 
Automatic Weather Stations (AWS), CLICOM ASCII, NOAA GTS and Text Files; 

 Facilities for exporting climatic data in formats ready for use by many climate applications 
(e.g.: RCLIMDEX, CPT, GEOCLIM, INSTAT, R- INSTAT, ENACTS, CDT, etc.); 

 Management of images of paper records (paper archives) in support of Data Rescue 
(DARE); 

 Quality Control checking of data that has been loaded into the database;  

 A number of Products, application programs which use subsets of the data stored in the 
database to produce useful reports, summaries and diagrams; and  

 System management facilities for managing user access, operations monitoring, 
administering the database and for tailoring the functions of the system to local needs. 
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2. Installation 

2.1 System Requirements 

Hardware: 

The Climsoft system requires the following typical hardware specifications: 

Computer with processor speed of 1 GHz, 2 GB RAM and enough disk space for installation of 
application software and storage of database. A minimum of 20 GB disk space is recommended. 
More disk space will be required for storage of AWS data and images of paper records for Data 
Rescue. However, it would be ideal to store images of paper records on removable storage 
media like external hard drives or Network Attached Storage (NAS). 

Internet connection is also desirable. 

 

Software: 

 Microsoft Windows 7 or later, 64-bit Operating System (OS) is recommended for optimum 
performance of the database. Climsoft Version 4 is compatible with the following Windows 
Operating Systems: XP, Vista, Windows 7, Windows 8.x, Windows 10  and Windows 11; 

 Microsoft Office with Excel spreadsheet is required since Excel spreadsheet application is 
the default application for displaying data products from Climsoft;  

 Antivirus software; 

 Minimum.Net Framework 4.5 is required. This version of the .NET framework is packaged 
with the Climsoft setup package; 

 Climsoft installation setup. Can be downloaded from met-eLearning site. Registration may 
be required. 

 MariaDB/MySQL database system and Climsoft database scripts which are also supplied 
through Climsoft installer and will be copied into the subfolder called "dbase" in the 
installation path; 

 WRPlot software for Windrose plotting which will be copied into subfolder called "Bin" in the 
installation path. 
 

2.2 Installation Procedures 

Please ensure that your PC meets the hardware and software requirements before you install 
Climsoft. You must also have Windows Administrator privileges for you to be able to 
install Climsoft. 

There are two setup packages for Climsoft, one for 32-bit Windows Operating System (OS) and 
the other for 64-bit OS. Choose the setup package that matches your Operating System. 

1. Run the setup executable file with elevated privileges. To do this, right click on the setup 
file and choose "Run as Administrator" on the pop-up menu. 

2.  "climsoftv4_bit32_setup.exe" is for 32 - bit OS and “climsoftv4_bit64_setup.exe" is for 
64-bit OS. The setup Wizard will guide you through the installation process. 
 

3. When the core Climsoft setup has been completed, a dialog with options for installing 
additional applications required by Climsoft will appear as shown in Figure 1 below. 

https://www.met-elearning.org/course/view.php?id=58#section-2
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Figure 1(a): Installation of additional applications 

You may uncheck the selected applications if they are already installed or you would wish to 
install them after Climsoft installation. If you choose to install them later then find their installers 
in the ‘bin’ folder of the installation path.  
 
If you choose the default selections the applications listed in the above dialog will be installed 
automatically in the order they are listed on the above dialog. However, if the version of 
Microsoft .Net Framework on your computer is old and need to be upgraded, the system will 
prompt you to do the upgrade, below is an example of a typical error message you may get: 
 

 
Figure 1(b): Dot Net Framework Initialisation Error  
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If you get a warning showing that you have a newer version of one of these applications already, 
click the Close button to continue with the installation of the next application.  

 

When you get to the installation of MariaDB, and you reach the point of specifying the Port 
number for running the MariaDB Service, it is strongly recommended that you choose the 
Port 3308, this is the port number defined in the configuration file of Climsoft for connecting to 
the MariaDB database that comes with the Climsoft setup. If you choose a different number, you 
will need to reconfigure the connection to the database at the login dialog to make the port 
number the same as the one you have configured during the MariaDB setup. 
 
It is also important to note that the password that you define during the installation and 
configuration of MariaDB will be required when you login to Climsoft for the first time. 
 
NOTE: If prompted to restart the computer before all selected installations are complete, 
please choose "restart later" and then restart the computer when all installations are 
complete. 
 
If the installation of WRPlot appears to take too long to complete, check for a second installation 
dialog that may be minimized on the bottom of the task bar requiring your input. If that dialog is 
there, open it and respond as appropriate. 
 
Although WRPLot is a freeware, you need a license key to activate this application. An initial 
license key which is valid for one year is contained in the file "WRPLot_license.txt" in the sub 
folder "Bin" in the Climsoft installation folder. To renew the licence you will need to visit the  
"Lakes Environmental" website at http: //www.weblakes.com/. This URL is also provided on 
the "About" box of the WRPlot application. The latest version of WRPLOT application can also 
be downloaded from this site. 
 
If you need to install, or re-install MariaDB or WRPLot later, the installation files for these 
applications are contained in the "Bin" sub folder of the CLIMSOFT installation folder. 
 

2.3 Creating Climsoft Database in MariaDB  

After the successful installation of Climsoft and MariaDB (MySQL database engine), you need 
to run the script to create the Climsoft database at the MySQL Client prompt. 

 Follow the steps below to run the script: 

(i) Launch MariaDB Prompt from your Start Windows program by clicking on the MySQL Client 

(MariaDB xx.x) as illustrated in Figure 2. You can also type the name “MariaDB” in the 

search box.  Dialogs obtained may look different, depending on your Version of Windows. 
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 Figure 2: Launching the MariaDB Client 

 
 
The dialog for entering the password then appears as shown in Figure 3. 

 
Figure 3: Entering the password on the MariaDB Client Prompt 
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Note that the user name is assumed to be “root”. (There is no provision for entering the 
username if you have launched the MariaDB Client Prompt as described above.) 

If you have entered the correct password i.e. the same password that you entered during the 
installation and configuration of MariaDB, the prompt then appears as shown in Figure 4. 

 
Figure 4: MariaDB Prompt after entering correct password 

 

(ii) Assuming the script file for creating the CLIMSOFT V4 database is in the Path “C:\Program 

Files (x86)\ClimsoftV4\Dbase”  

Type the following command at the prompt: 

“Source C:\Program Files (x86)\Climsoftv4\Dbase\mariadb_climsoft_db_v4_all.sql” 

Then press the Enter key. (This assumes the script file for creating the Climsoftv4 database 

is in the Path “C:\Program Files (x86)\Climsoftv4\Dbase”) 

If you have typed the command correctly, the script will create the Climsoft Version 4 
databases; Two (2) databases are created, the operational database 
(mariadb_climsoft_db_v4) and the test database which contains data for training and testing 
purposes (mariadb_climsoft_test_db_v4). 

(iii) To check or verify that Climsoft Version 4 databases have been created in MariaDB database 

engine, type: “Show databases;” command at the MariaDB Client Prompt and press the 

Enter Key. The 2 Climsoft databases will then listed together with other database schemas 

that come with MariaDB as shown in Fig 4a. 
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Figure 4a: List of databases (Schema) MariaDB database engine 

2.4 Climsoft First Login for Climsoft 

You are now ready to launch the Climsoft Version 4 application. Double click the Climsoft icon 

on the desktop to launch the Climsoft Version 4 application and login (Figure 6). On the first 

login, the User name must be “root” and the Password that was created during MariaDB/MySQL 

database engine installation. You may check the box Remember username so that the User 

name is remembered during the next login. 

 
Figure 6: Climsoft Version 4 Login Dialog 

 

(iv) If you are sure you have typed the correct password but have been denied access, click   on 

the blue label “Manage database connections” on the above dialog to check the database 

connection details and adjust accordingly. Then a dialog similar to Figure 7 appears. 
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Figure 7: Database connection details 

 

If the MariaDB database to which you want to connect is on your local computer then the server 
must be either “localhost” or “127.0.0.1”. If the port number you chose during the installation of 
MariaDB is different from “3308” as shown on the screenshot above, you will need to change 
the port number to the correct one and click Ok. More details on how to manage database 
connections are given in section 2.5.2 below. 

After successful login, the Climsoft front-end will appear as shown (Figure 8). From the front-
end, you can access all the components of the Climsoft CDMS, either through the top menu or 
by clicking the icons on the Welcome screen.  

However, a user will be able to access only the features corresponding to the privileges 
associated with the user- group to which they belong. 
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2.5 Updated Climsoft Login and Database Connection 

2.5.1 Login Dialog 

 
Figure 6a : Climsoft Login Dialog 

2.5.2 Database Connection Dialog 

 

Figure 7a: Database connection details 

 

Note that Climsoft V4 installation comes with two databases; one as the operational database 
while the one as test database. The test database is populated with observational data and 
metadata obtained from different NMHSs. In order to use the test database, it must be listed in 
the Database Connections as shown in Figure 7a and be selected at the Login dialog through 
the Database list box.  

To Login 

Enter user name in User Name box 

Enter Password in Password box 
 

To Change database connection Click 

on Manage database connections then 

follow dialog in Figure 7a 
 

To remember user name in subsequent 

logins 

Check the box Remember username 
 

To Set the Language to use 

Click on Change Language to select the 

appropriate language from the 

subsequent dialog 

To connect to any of the listed 

databases 

 Select the database by clicking on the 

left most cell of that row, 

 Click on the button Make default. 

 Click OK to save changes and close 

the dialog. 

 

To connect to a database that is not 

listed 

 Enter the database details in the new 

row marked *, 

 Follow the provided Example 

connections to fill all cells for that row, 

 Click on the button Make default, 

 Click OK to save changes and close the 

dialog. 
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3. Climsoft Main Menu and Welcome Dialog 
 

After a successful Login the main interface for Climsoft Version 4 displays (see Figure 8). It is 
referred to as the Welcome Dialog and consists of the Main Menu and icons through which all 
the functionalities are accessed.  

 

 
Figure 8: Welcome Dialog 

The functions that are accessed from this dialog are as follows: 

3.1 Menu Bar Items 

 Input – Opens key entry forms and the paper archive dialog; 

 Accessories – Opens the calculation of Relative Humidity and Dew point, given the Dry 
Bulb and Wet bulb temperatures; 

 Products – Opens the Climate products development dialog; 

 QC – Data quality control functions; 

 Administration – Functions for administration of users and the database. This feature is 
only accessible to administrators; 

 Change own password – Open the dialog for users to change their passwords; 

 Tools – Opens dialogs for different operational settings; 

 Help – About Climsoft V4 and online help on how to undertake various operations. 
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3.2 Main Menu Icons 

 Data Entry – Lists key entry forms to enter climate data. Same as in the menu Input; 

 Data Transfer – Opens a dialog for data upload, import (external data), backup and 
restore; 

 Users Administration – Opens a dialog for adding users and updating their details. . 
Same as in the menu Administration; 

 AWS Real Time Processing – Opens a dialog for setting up and managing Automatic 
Weather Station (AWS) data real time operations; 

 Archive Paper Image - Opens a dialog for managing paper images. Same as in the 
Menu; 

 Quality Control checks - Opens a dialog for quality control checks. Same as in the menu 
Input; 

 Climate Products - Opens a dialog to extract climate products. Same as in the menu 
QC; 

 Metadata Information - Opens the metadata management dialog; 

 Close – For Climsoft Shut down. 
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4. User Management and Configuration Settings  

4.1 User Management 

The default user of the Climsoft CDMS is “root”. This is the super user of the system with access 
to all the features of the Climsoft CDMS. To allow other users to make use of the system, the 
“root” user must add new users and assign them to different user groups. The different user 
groups that have been pre-defined for Climsoft are shown in Table1: 

User Group  Summarized access rights 

ClimsoftAdmin All Climsoft features including creating and deleting other users 

ClimsoftDeveloper Modification of all Climsoft features 

ClimsoftMetadata Updating of metadata e.g. station information, instruments, etc. 

ClimsoftOperator Key-entry of observation data 

ClimsoftOperatorSupervisor Key-entry plus uploading key-entry data to observationinitial 
table 

ClimsoftProducts Extracting products from Climsoft 

ClimsoftQC Key-entry, upload to observationintial and Quality Control 

ClimsoftRainfall Key-entry of only rainfall data 

Table 1: CLIMSOFT user roles 

The “root” user or any other user with administrative privileges is able to access the user 
management dialog by clicking the “User Management” icon on the Welcome screen or via the 
“Administration” menu. The dialog for User Management is shown in Figure 9. 

 

Figure 9: Climsoft user management 

 

The user management dialog is self-explanatory. The “Add New” button is enabled after filling 
all the text boxes and picking the user role from the dropdown list. 
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Apart from creating new users, the Climsoft administrator can change the Password and also 
the User Role of any user. To change the password for the selected user, the new password 
must be entered and confirmed in the Password and Confirm Password boxes respectively 
then click Update button. The user role is changed by selecting the new one from the user Role 
list box then click the buttons Update and Refresh Privileges in that order. 

Any user can change his/her own password via the menu item “Change own password” on the 
Welcome form in Figure 8. 

The root user is managed through the database engine tools but not through the User 
Management dialog. 

4.2 Configuring General Settings 

To customize Climsoft for local use, the Climsoft administrator must configure the system via 
Tools >> General Settings from the top menu on the Climsoft front-end. Figure 10a shows the 
dialog for configuring the general settings in a view displaying one record at a time. 

 
Figure 10a: General settings in a single record view mode 

 

The Administrator must navigate through all the records in the dialog and change the contents 
in the text box to the right of the label “Setting Value” to suit the required local configuration. 
After changing any record click Update button before going to the next. 

Alternatively, by clicking the “View” button, the settings can be viewed and edited in datasheet 
(table) view as shown in Figure 10b 
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Figure 10b: General settings in datasheet view mode 

You may increase the columns width in the data sheet to see more details by dragging the 
columns boundaries to the right. With administrative privileges the records may be updated but 
not deleting or adding. Update and Delete buttons are enabled after clicking the button Edit 
Mode. Values in the column “KeyName” should not be changed because they are used by 
Climsoft to reference the selected record.  

Through Export button the displayed records can be exported into a text (csv) file and saved as 
a backup data. The Import button does the reverse.  
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5. Metadata Management 
 

Climsoft uses metadata to describe the data archived in its database. It is therefore important to 
manage the metadata well and ensure all metadata is in place before the data it describes is 
loaded into the Climsoft database. The dialog shown in Figure 11 below facilitates management 
of all metadata in the Climsoft database. Each tab opens a dialog for the management of each 
of the metadata type. 

 
 
Figure 11: Metadata Management 
The dialog in Figure 11 is for the station metadata. All other metadata dialogs have a similar 
structure.  

The Station metadata dialog has the following controls: 

 Text boxes – For the input of metadata values or showing the values for the selected 
record; 

 Scroll bar and buttons – To navigate through the metadata records; 

 Searching records; 
o Search Station Name list box – Searches station for the selected name and 

displays its details in the text boxes, 
o Station Id list box – Also searches a station record by selecting and clicking the 

station Id value from the list. Details of the selected station will be shown in their 
appropriate text boxes. 

 Latitude and Longitude MUST be entered in decimal degrees. Where geographical 
coordinates are not available in decimal values but in degrees, minutes and seconds 
they may be entered in the provided boxes for conversion. They will get computed and 
filled into the appropriate boxes once the N/S or E/W is selected. 
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 Command Buttons: 
o AddNew – Adds a new metadata record after details have been typed in. The 

Station Id is mandatory and must be unique in all records; 
o Save – Adds and saves a new station record in the database whose details have 

been typed;  
o Update – Updates the changes made on the selected record; 
o Delete – Removes the selected and displayed record from the database; 
o View – Displays the metadata records in a tabular form. The Export button will export 

the metadata file in csv format; 
o Import – Opens a dialog through which stations metadata in a text (csv) can be 

imported into Climsoft. By clicking the Import Command button the dialog in 
Figure12 below appears; 

5.1 Importing Station Metadata 

 
 

Figure 12: Importing stations metadata 

 

The metadata import file can be created using EXCEL then saved as Comma Separated Values 
(CSV) with column headers. In EXCEL the structure is as shown in Figure 13; 
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Figure 13: structure of station metadata file in Excel 

After saving in a text (csv) format the data appears as shown in Figure 14. 

 
Figure 14: structure of station metadata file in Notepad. 
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5.1.1 Station Metadata Import procedure 

 From the Metadata Import dialog, Figure 12, open the text file containing the stations 
metadata; 

 The column headers in the text file are listed in the Import Field Name column of the 
dialog; 

 For each field in the list click twice (not double click) on the Select Field to select the 
corresponding field name from the database; 

 Click the Import command. The metadata will then be imported and any station that fails 
to be imported will be listed in Errors message box with the cause of the failure. The 
summary of the importing will be listed below that box. 

 Scroll through the error messages, correct the text file and repeat the exercise. Duplicate 
error messages should be ignored since they indicate the record already exists in the 
database. 

 Click Close to exit the dialog. 

5.2 Other Metadata 

Other metadata types do not require importing but are typed since they are usually few. 

5.2.1 Elements Metadata  

Observation elements are many and are supplied with Climsoft. They can be edited after clicking 
the Element tab to display the Observation Element dialog. This dialog enables the 
characteristics of a new climatic element to be specified and those of existing elements modified. 
Generally the elements will be standard but modification to customize them according to the 
user requirements is necessary. If there are Elements observed in a NMHS and not listed they 
should be added. 

The elements may be viewed and updated in either Element view, Figure 15, or in Table View, 
Figure 16. Click the View button in Figure 15 to move to the Table view.  In Table View, Click 
the View Mode button to return to the Element view of Figure 15. 

 
Figure 15: Elements dialog 
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The dialog in Figure 15 is used as follows: 

(i) Adding a new element record: 

 Click AddNew  to obtain a blank form; 

 Enter metadata values for the element;  

o Data for ID is mandatory and unique in all records, 

o Scale is the factor used in key entry for the decimal point. Therefore 
Upper Limit and Lower Limit values should take the scale into account, 

o Type is the frequency of observation e.g., minute, hourly, daily, AWS. 

 Click Save to add the new record in database. 

(ii) Updating (editing) existing element record: 

 Use either Search Element box or ID to locate the required element record, 

 Edit the desired values, 

 Click Update to save the changes. 

(iii) Deleting elements 

 Use either Search Element box or ID to locate the required element record 

 Click Delete 

Alternatively move to Table View, Figure 16 and use the command buttons as described 
below; 

 
Figure 16: Elements in table view 
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Use the commands as follows; 

 Delete: Delete the current record by selecting on clicking the left most cell, 

 Update: Updates changes made on the current (selected) record, 

 View Mode: Switches between View and Edit mode, 

 Export: Exports all the elements metadata into a text CSV file, 

 Import: Imports elements metadata file from an Export operation.  

 Close: Closes the view table, 

 Help: Online help on how to use this dialog. 

(iv) Selected elements 

This box is used to select elements that will be listed in various dialogs where element list is 
required. Use this box and check (tick) for the required elements and uncheck (untick) for 
those that are not required. Note that Climsoft dialogs for different operations that have 
boxes for elements selection will only list the selected elements. Remember to click the 
Update button whenever the box is checked or unchecked otherwise the action will not be 
saved.  

(v) Total Required 

  By default this box is unchecked (unticked).  The box is used to check for those elements 
whose sum for the observation values will require to be entered in the key entry forms. This 
action is purely for QC purposes where the sum of the entered values will be compared with 
the totals computed by the observer. Those other elements without computed totals for key 
entry forms should not be checked. Remember to click the Update button whenever the box 
is checked or unchecked otherwise the action will not be saved. 

5.2.2 Station Element  

The details of the elements observed at a particular station are entered here: 

This dialog enables the editing and updating of element information as recorded at a particular 
station. Before adding a station element record in this dialog the stationId, elementId, 
instrumentId and scheduleclass that describes this element should first be entered in their 
respective tables through the provided dialogs (under the Tabs) in that order. The value for 
Instrument Type is a code that can be obtained from the WMO Code and Flag tables manual. 
Not all instruments that have codes. In that case the box is left blank. Some of the Instrument 
types described in Code and Flag table are for measurement of evaporation and wind. 
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Figure 17: Station Element details 

5.2.3 Instruments  

This dialog enables the system administrator to specify the characteristics of a particular 
instrument used to record an element at a given station. 

 
Figure 18: Instrument details 
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5.2.4 Station Location History 

The detailed history of the station locations are shown in the dialog in Figure 19. 

 
Figure 19: Station Location History 

5.2.5 Station Qualifier 

The qualifiers for the stations are described through the dialog shown in Figure 20. 

 
Figure 20: Station Qualifier 
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5.2.6 Schedule Class 

Various observation schedule classes can be defined in Climsoft as shown in Figure 21. 

 
Figure 21: Schedule Class 

5.2.7 Physical Feature 

The detailed Physical features at the station’s environment are shown in Figure 22.

 
Figure 22: Physical Features 
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5.2.8 Paper Archive Definition 

Metadata definitions of the paper images to be archived are shown in Figure 23 This 
information should be entered before the paper archive record can be added. Paper archiving 
operation is described in Chapter 12. 

 
Figure 23: Paper Archive Definition 
 
 

6. Key Entry 

Climsoft comes with a list of Key-entry forms for a user to choose the form that suits the set of 
data to be entered. To start, the Climsoft administrator selects only those forms required by the 
key entry operators. The following paragraph describes how the key entry administration and 
operations are undertaken. 

6.1 Setting up Key Entry Forms List 

To access the list of all available key-entry forms, login as administrator and follow the steps 
below; 

 From the Welcome form click the menu Administration then Data Forms to obtain the 
dialog in Figure 24. 
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Figure 24: Key Entry Forms Settings 

 Check the boxes for those forms to be shown and uncheck for those to hide, 

 Click Apply to save the changes and Cancel to close the dialog. 

6.2 Opening a Key Entry Form 

 From the Welcome form click on the icon Data Entry to obtain the dialog shown in Figure 
25; 

 
Figure 25: Key Entry forms opening 

 Double click on the required form or select the form. Press the Enter key to open it, 

 Clicking OK also opens the selected form, 

 Select Cancel to close the dialog. 
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6.3 Key Entry Forms Layout 

All key-entry forms in Climsoft have the same general layout. Figure 26 shows a sample 
screenshot of the form for entering hourly data. 

Just below the title bar, there are controls for header information associated with an observation, 
typically station identifier, date/time information and element identifier.  

Below the header area are text boxes for entering observation values, and near the bottom of 
the key-entry form is a data control for navigating through key-entry records.  

Further down are buttons for triggering various key-entry actions e.g. the action to enter a new 
record.  

When the “Add New” button is clicked, the header information for a selected form automatically 
moves to the next record to be entered.  

 
Figure 26: Key Entry form for hourly data 

6.4 Key Entry Sequencer 

Assuming that the next element for which observation data will be entered is “Temp wet bulb” 
which is short form for wet-bulb temperature, then the value in the element list box will 
automatically change to “Temp wet bulb”. When the “Add New” button is clicked, the order in 
which the element abbreviation changes on the element list box is controlled by what is called a 
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“sequencer” in Climsoft. There is therefore need to customize the order or sequence in which 
the element name changes on the element list box. The name of the sequencer for the key-entry 
form is displayed in the text box below the key-entry buttons on the key-entry form. 

For Hourly data, the required sequencer configuration is done on the appropriate dialog which 
is accessed via the top menu on the Climsoft front-end by clicking on Tools >>Sequencer 
configuration >>hourly. Figure 27 shows a screenshot of the dialog for configuring the 
sequencer for hourly data. The dialog is intuitive, with some guidelines in the top part of the form. 
Only element_code values that are typed in and the seq values filled by Climsoft. 

 
Figure 27:  Dialog for configuring the sequencer for hourly data 

The dialog for configuring the sequencer for daily data is accessed via Tools >> Sequencer 
configuration >> Daily. A screenshot of the dialog is shown in Figure 28.  

 
Figure 28: Dialog for configuring sequencer for daily data 

Similarly, the dialog for configuring the sequencer for monthly data is accessed via Tools >> 
Sequencer configuration >> Monthly. A screenshot of the dialog is shown in Figure 29.  
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Figure 29: Dialog for configuring sequencer for monthly data 

 

The dialog for configuring the sequencer for hourly data for the whole month is accessed via 
Tools >> Sequencer configuration >> Hourly2. A screenshot of the dialog is shown in 
Figure 29a.  

  
Figure 29a: Dialog for configuring sequencer for monthly data 

 
In addition to the sequence of the elements, the date/time sequence is also changed 
automatically. This sequence does not require customization since it is the same for any 
location. 

The form_hourly2 allows key entry for hourly data that 

is organized in hourly columns for the whole month. The 

sequencer is configured as shown in Figure 29a. Hours 

that are described in the data columns are selected as 

demonstrated in the configuration dialog. If there is data 

for all hours then all the hours are selected by checking 

every box in the Select column  
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6.5 Configuring synoptic hours for key entry 

The form for hourly data can also be used for entering data for selected hours. This is done by 
disabling the text boxes for only the hours with data by clicking the button “Enable Selected 
hours only”. This button is located just below the header information. Figure 30 shows the 
hourly form when key-entry is enabled for synoptic hours data entry. To ignore the hours 
selection and enter data for all hours click again on the same button while it reads “Enable all 
hours” 

 
Figure 30: Hourly form enabled just for synoptic hours 
 

When the button “Enable selected hours only” has been clicked, its label immediately changes 
to “Enable all hours”, so it allows toggling between “all hours” and “selected hours”. The dialog 
for configuring the selected hours that would be enabled is accessed via Tools >> FormHourly 
time selection. A screenshot of the dialog is shown in Figure 31. From this dialog any set of 
hours can be selected for data entry. For instance for those NMHs that operate for 12 hour only 
say from 06 – 18 may wish to enable those hours only for data entry. Always remember to click 
the button “Enable selected hours only” if not all hours are used (i.e not 0….23) 
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Figure 31: Configuring synoptic hours to be enabled on hourly form 

6.6 Key Entry Operation 

It is a strict requirement in Climsoft to enter station information in the station table before any 
key entry operation is done. The same requirement applies to importing of external data. Hence 
update the station information before attempting any of these operations. See the metadata 
section for the necessary instructions. 

For key entry, it is also important to check the element information which comes with the Climsoft 
setup to ensure that all required elements are clearly defined, elements limits for QC are adjusted 
and any other properties where necessary, to meet local needs. 

To start key entry, click on the “Data Entry” icon on the Climsoft “Welcome” screen. Select the 
key entry form that corresponds to the data to be entered and double-click on the selected form.  

The use of the key entry forms is quite intuitive, so there is no need for detailed guidelines except 
to highlight the common aspects that apply to all key-entry forms, and some features related to 
specific forms. 

 After selecting a value from a dropdown list e.g. a station name, or entering a value in a 
text box, the Enter key must be pressed for the value to be registered on the form and 
for the cursor to move to the next cell. 

 Some key entry forms have a provision for entering the “Total” for elements that require 
the sum of values for a particular column of observation data. The Climsoft administrator 
must configure the metadata in the element table to enforce the requirement for the total 
to be entered for the elements that need a total to be entered during key entry. 

 Some buttons are enabled or disabled depending on the situation. For example, the 
“Save” button is enabled only after clicking the “Add New” button to enter a new record. 



 35 

Then the same “Add New” button is automatically disabled until the “Save” button has 
been clicked to save data for the newly added record. 

 When the cursor leaves a particular text box or dropdown list after pressing the “Enter” 
key, quality control (QC) checks are carried out on the value that has just been entered. 
Figure 32 shows a QC message after entering a value that has failed the QC check for 
upper limits when entering daily data. 

 
Figure 32: QC checks during key entry 

 All key-entry forms have an “Upload” button for transferring data from a key-entry table into 
a common table named “observationinitial” where more QC checks are carried out.  

 The Upload button is not enabled for a user with the role of operator, but is enabled for 
users with the role of operator supervisor, QC and administrator, 

 All key-entry forms have a “View” button for viewing the data that has been entered in 
datasheet view, Figure 32. To facilitate locating a required record, the rows are in ascending 
order by station ID, element ID, and date/time attributes, 

 In the datasheet view, a key-entry operator can delete or update own records in the data 
entry table using the Delete or Update command button if the “Edit Mode” is active. To 
activate the “Edit Mode” simply click the command button “Edit Mode”,  

 The “Export” command button exports all the records entered in the data entry form in a csv 
file for further processing, 

 The “Import” command button is used to import data that had been saved into a text file 
through the Export command.  Together Export and Import operations can act as backup 
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and restore of data in key entry forms. They can also be used to transfer data between 
Climsoft servers, 

 An important feature of the datasheet view functionality is that in a network arrangement 
where multiple key-entry operators enter data into the same key-entry table from different 
workstations, a key-entry operator can only view and make changes to the data records that 
he/she has entered. The Administrator will be able to view all data records and make 
changes 

 

Figure 33: Key entry datasheet view 

 

6.6.1 Some special features for specific key entry forms 

(i) Just below the header area of the form for daily data shown in Figure 22, there is a section 
indicating units of measurement for some elements. This is to accommodate entering 
historical data over different periods where the units of measurement for those elements 
have changed. For example, old historical paper records in some National Meteorological 
and Hydrological Services (NMHSs) had units of degrees Fahrenheit for temperature which 
were later changed to degrees Celsius. Similarly, old records for precipitation could have 
units of inches which were later changed to millimeters. 

(ii) The form for daily data is designed for entering different elements, with the next element 
being changed automatically after clicking the “Add New” button, being controlled by the 
sequencer. However, sometimes only a single element is entered, especially for data from 
rainfall stations. In such cases, the element sequencer can be turned off by unchecking the 
“enable element sequencer” checkbox. 
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(iii) The form for daily data has text boxes for entering observations values for each day from 
day 1 up to a maximum of day 31. If the value of the month entered in the header section 
of the month has a maximum number of days less than 31, text boxes associated with day 
numbers beyond the maximum number of days for that month are disabled. This applies 
to months with 30 days and also for February with 29 days for a leap year and 28 days for 
a non-leap year. 

(iv) The daily form and the hourly form have a provision to assign the same value for all 
observation days for a particular element. This is most appropriate especially when 
entering rainfall values of zero for the whole month, thereby reducing the number of key 
strokes substantially. 

(v) As described under the section on “Configuring selected hours for key entry”, the hourly 
form can be configured for entering observation data for all hours or for selected hours. 

(vi) The form for entering hourly wind data provides for fast entering of wind direction and speed 
as one number in the same text box with the direction and speed automatically separated 
into different text boxes. The splitting of the combined wind value into direction and speed 
is based on the configured number of digits for direction and speed. This configuration 
described under “Tools => general settings”. This form also has provision for entering 
wind data for all hours or for selected synoptic hours, similarly to the configuration available 
on the hourly form. 

(vii) The form for entering synoptic data for an observation made up of many elements at the 
same hour of observation, shown in Figure 35, provides for the automatic calculation of 
derived elements, namely, mean sea level pressure, geopotential height, dew-point 
temperature and relative humidity. 

NOTE: The automatic calculation of mean sea level pressure and geopotential height 
require station elevation data to be available in the station metadata table. 

(viii) Any key entry form will not accept data for future dates. A message will be prompted if 
the date selected manually or by the sequencer is beyond the current date. 
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Key entry form for hourly wind speed and direction 
 

 

Figure 34: Key entry form for hourly wind 
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Key entry form for Synoptic observations 

 
Figure 35: Key entry form for many elements observed at the same time 
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Key entry form for Upper Air observations 

The form for entering upper air observations is made up of many elements at the standard 
pressure levels namely Surface, 1000, 925, 850, 700, 500, 400, 300, 250, 200,150,100, 70, 50, 30, 

20,10 shown in Figure 35a. The key entry is sequenced in the order of Levels, Day, Month 
and Year. At the metadata configuration the observation elements for the upper air data 
should be configured as detailed in Table 2 below. However, the QC limits and units should 
be set according to the observation practice at the given centre. 

 
Figure 35a: Key entry form for upper air observations at standard levels  
 

Element Id Abbreviation Element Name Description Element Type 
301 PRESS Pressure Level Pressure level Upper Air 
302 HEIGHT Height of Pressure Level Height of pressure level Upper Air 
303 TEMPDB Temp at Press Lvl Temperature at pressure level Upper Air 
304 DPTDEP Dew Point Depress at Press Lvl Dew point depression at pressure level Upper Air 
305 WNDDIR Wind Dir at Press Lvl Wind direction at pressure level Upper Air 
306 WNDSPD Wind Spd at Pressure Lvl Wind speed at pressure level Upper Air 
307 WNDSHR1B Wind Sheer 1km lyr blw Wind shear 1km layer below Upper Air 
308 WNDSHR1A Wind Sheer 1km lyr abv Wind sheer 1km layer above at pressure level Upper Air 
309 LATHDISP Lat displ at pressure lvl Latitude Displacement at Pressure Level Upper Air 
310 LONGHDISP Lon Displ at press lvl Longitude Displacement at Pressure Level Upper Air 
311 ACCTMDISP Time Displ at press lvl Time Displacement at Pressure Level Upper Air 
312 ACCVERSIG Vert Signf at press lvl Vertical Significant at Pressure Level Upper Air 
313 RELHUM RH at Press Lvl Relative Humidity at Pressure Level Upper Air 

Table 2: Upper observation elements details – To be configured in Elements Metadata 
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6.7 Emptying Key Entry Tables 

This operation facilitates emptying of key entry tables. This is necessary to avoid records growing 
to a point of slowing key entry and data uploading processes. However, it should be ensured 
that, before emptying any table the data therein has been uploaded, quality controlled, errors 
corrected, uploaded to the final database table and is ready for products generation. 

This operation is undertaken through the dialog shown in Fig 36 as follows: 

(i) From the Main Menu click “Administration” -> “Empty Key Entry Forms”, 
(ii) On the Forms List check the box(es) for the form whose data is to be emptied, 
(iii) Select the records within the selected form that are to be deleted. Choose either the option 

“All Records” or “Selected Records”. In case of “Selected Records” enter the required 
time range in the relevant boxes, 

(iv) By default all the records that have not been uploaded to either “observationinitial” or 
“observationfinal” table but are within the selected option will not be deleted from the 
key entry table. But if it is felt that they must be deleted and re-entered later then uncheck 
the box “Skip Records Not Uploaded”. 

 
Figure 36: Dialog for Emptying Key Entry Forms 

6.8 Operational Monitoring 

During the key entry operation, details of the operator are captured. They are login name and 
entry date time. These details can be used to monitor data entered by any operator. The 
monitoring operation is started through “Administration” -> “Operations Monitoring” to obtain 
the dialog similar to Figure 36. The tabs on the dialog describe the different processes 
undertaken in the monitoring operation. They are: 
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(i) User Records: See Figure 37. The Administrator can monitor records for a single 
operator or for all operators combined depending on the option selected. Any operator 
can monitor own records through Accessories -> User Records. In this case only the 
records for the current login operator that will be displayed. The Start Date and End Date 
should be appropriately selected then click View Records.  

(ii) Settings: The other 2 operations namely Performance Monitoring and Double Key Entry 
Verifications require some prior settings before they are undertaken. This is done through 
the tab “Settings” as described in section 6.8.2. 

6.8.1 Users Records 

 
Figure 37: Operations monitoring dialog 

6.8.2 Settings 
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Figure 38: Operations monitoring settings dialog 
 

To undertake any of the operation in this dialog select the required settings option and click View 
to obtain a grid table from where the values are set as follows: 

 

(i) Target Records 

 
Figure 39: Target records setting 
 

Enter the target value for each operator against which the performance for the selected period 
will be measured then click Update.  

(ii) Data Entry mode: 

 
Figure 40: Data entry mode settings 

If any of the listed forms requires to be set to double key entry status then the entry mode should 
be set to 1 in the column “entry_mode” and click Update. On reverse it should be set to 0. 
While in double entry mode, data entered will be compared with the previous entry. Where the 
2 entries conflict the operator will be prompted for a repeat entry. A form that is set for double 
key entry will not accept any data that has not been previously entered. To enter new data the 
key entry mode has to be set back to 0 (single data entry). 

6.8.3 Performance Monitoring 

Performance monitoring can be done on monthly basis or for a selected period of time. Select 
the appropriate option then click “Compute Performance”. Click “Save Output” to save the 
performance output to a CSV file. See the dialog in Figure 41. 



 44 

 
Figure 41: Data entry mode settings 

 

6.8.4 Double Key Entry Verification 

Where key entry has been set to double entry mode it becomes necessary to verify which 
records have been repeated or otherwise. See Figure 42. The verification can be done for single 
form or all of them combined. From the dialog make the selections correctly then click “Retrieve”. 
The records that suit the selected criteria will be listed. Click “Save” to output the records in CSV 
file and opened in EXCEL. 

 
Figure 42: Double key entry verification 
  



 45 

7. Post Key Entry Quality Control Checks 

Climsoft provides a facility for further Quality Control (QC) checks on data that has been 
uploaded from key-entry tables or imported from external sources into the “observationinitial” 
table. The dialog for these QC checks, shown in Figure 43, is accessed by clicking the icon 
“Quality Control Checks” on the Welcome screen. 

 
Figure 43: Quality Control Checks 

QC operations in Climsoft are carried out by first selecting the option for the required QC type 
and then providing all other information as shown in the dialog in Figure 43 above. This dialog 
is simple and self-explanatory. Stations and Elements can be selected either through the list box 
or checking on the boxes in front of their Ids or Codes respectively. As many stations and 
elements can be selected as necessary. If any required item (station or element) is not shown 
scroll bars can be used so that they are displayed and selected  

Perform QC button is used to start the process and any data that fails the QC test will be saved 
in text (CSV) file and displayed in EXCEL once the operation is completed. The generated files 
usually referred as the QC Report files are saved in the folder that had been configured in 
General Settings as described in Section 4.2 and Figure 10a above.  . 

Following are the details of each QC type: 

(i) Absolute limits checks  

This is the default option and this QC is mandatory on all new data in Climsoft. It checks for data 
values that exceeds the element limits that have been set in the elements metadata. Two (2) 
report files are generated one for data that exceeds the upper limits and the one for the lower 
limits. The files names are automatically generated and structured according to the limit type 
and the data period e.g. qc_report_upperlimit_202101_202112.csv) and 
qc_report_lowerlimit_202101_202112.csv). 
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The report on the screenshot in Figure 44 shows two values of maximum temperature, 6.6 and 
6.4 that are below the lower limit of 12.0 for maximum temperature. The other useful information 
displayed is the station ID, element ID, date/time, the username of the person who entered the 
data and the key-entry form used for entering the data. 

Figure 44: QC report showing values below lower limit 

(ii) Inter-element comparison checks 

The QC under this option, different types of temperature data for every day in the selected time 
range and from selected stations are compared. The compared temperature observations are 
maximum, minimum, dry bulb, wet bulb and dew point. In this operation, the elements are 
predetermined by Climsoft hence the Elements window in the dialog is disabled. Data that fail 
the comparison test is saved in report files located in the QC folder. Five output files in csv format 
are generated. Each file contains the report on related elements and the file names are 
structured such that the element codes and time period are included as listed below and also in 
Figure 45  

(a) Maximum and Minimum temperatures = qc_interelement_2_3_202101_202112.csv 

(b) Dry and Wet bulb temperatures =  qc_interelement_101_102_202101_202112.csv 

(c) Wet bulb and Dew point temperatures =  qc_interelement_102_103_202101_202112.csv 

(d) Maximum and Dry bulb temperatures = qc_interelement_2_101_202101_202112.csv 

(e) Dry bulb and Minimum temperatures =  qc_interelement_101_3_202101_202112.csv. 

                  
Figure 45: List of QC report files 
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Figure 46 shows a QC report for inter-element comparison. The report shows maximum 
temperatures (2) below dry bulb temperatures (101) for the same day. 

 
Figure 46: QC Report for inter-element comparison 

 

(iii) Diurnal range check 

The QC in this option checks for days whose data is very high or low as compared to the rest in 
a given month. For every element that is selected statistical values for upper and lower limits are 
computed (limitValue) for each month. All data that exceed those limits fail the QC check and 
are saved in a report file for confirmation and corrections where necessary. The QC report file 
name includes the selected time period e.g. qc_report_diurnalRange_198003_198005.csv. Figure 
46a shows data that fail the diurnal check QC for Maximum (2), Minimum (3), Dry bulb (101) and 
Wet bulb (102) temperatures. Diurnal range check process may take long to complete if a big 
time period is used. It is therefore recommended that shorter time periods say few months be 
considered. 

 
Figure 46a: QC Report for Diurnal range check 
 

(iv) Consecutive days consistency checks 

The QC in this option compares change in observation values between the current day and the 
previous one at the same hour. If the difference is higher than the expected statistical change 
data for both days fail the QC check and are saved in a report file for confirmation and corrections 
where necessary. The QC report file name includes the selected time period e.g. 
qc_report_consecutivedays_198006_198006.csv. Figure 46b shows data that fail the consecutive 
days consistency QC for Dry bulb (101) and Wet bulb (102) temperatures. 
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NOTE: 

The QC reports are saved in the folder configured for the QC reports under “General Settings”. 
Hence make sure that the folder for QC reports has been configured correctly. 

The name of the QC report file generated is based on the type of QC selected and the specified 
period for the QC.  

After analyzing a QC report and making any changes, the report with updated values should 
be saved with a different name. What is recommended is to add a suffix “_updated”. Both files 
should be maintained with data in the original one remaining unchanged. Data in the updated 
file can be edited as many times as the corrections are found necessary. 

7.1 Updating the database from a QC report 

To update the database from the QC report, the “Update With QC Report” button on the QC 
main dialog shown in Figure 43 should be clicked. When the “Update With QC Report” button 
has been clicked, the dialog in Figure 47 will appear, with provision to browse for the original QC 
report file and the updated report file. After clicking the “OK” button, the database is updated 
with the changes made in the QC report. 

 
Figure 47: Dialog for updating database from a QC report 

7.2 Transferring Data from “observationinitial” to “Observationfinal” table 

After quality control of the data in the “observationinitial” table, the QC’d data can be 
transferred to the “observationfinal” table from which products can be derived. The dialog for 
transferring data to the “observationfinal” table is accessed from the Welcome screen by 
clicking the “Data Transfer” icon, followed by clicking the menu “Upload” then “ObsInitial to 
Final” to open the dialog  shown in Figure 48. 
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Figure 48: Upload data to observationfinal table 

Data for the selected Stations and Elements for the period specified in the time range (Begin 

Year, End Year, Begin Month and End Month) will be transferred into the “observationfinal” table. 
The dialog is self-explanatory on how to select data to upload. Stations and Elements can be 
selected from the list box or the displayed view. The selected items will have the box to the left 
of the Id or Code checked. 

Click the “Upload” button to start the data transfer. The progress of data transfer will be shown 
in the progress box. 

Data that had been previously uploaded can be overwritten by checking the box “Update 
existing records”. Otherwise duplicate data will be ignored if uploaded. 

Only data that have gone through QC are uploaded to the “observationfinal” table. Observation 
records that have not yet been QC’d have a QC status flag of zero “0” while records that have 
been QC’d have a QC status flag of one “1”. That have been changed through QC update have 
QC status flag “2”. Therefore data with QC status flag “0” will not be uploaded to 
“observationfinal” 

7.3 Update Observations 

The Update Observations facility in Climsoft Version 4 enables users with administrative 
privileges to view and update data in the intermediate and final stages of the archiving process. 
The administrator is able to use the “Update Observations” dialog to view and modify (edit, 



 50 

update and delete) selected records in the database. The dialog is in two pages (Tabs) one for 
selecting the records; Figure 49a and the other for listing the selected records in a grid table; 
Figure 49b. The dialog is intuitive and easy follow. 

 

Figure 49a: Update Observations Dialog – Select records 
 

 

Figure 49b: Update Observations Dialog – View Selected records 

 

The view dialog is operated as follows: 



 51 

(v) Modify observations 

To modify an observation value, click on the particular cell and edit the data value therein to 
the correct one. Then click the “Update” button in order to save the changes after every 
modification. Note that only the observation value that can be modified in the entire row.  

(vi) Delete records 

Click “Delete” button to remove all the selected and displayed records from the selected table 
i.e. observation initial or observation final. A delete confirmation message will be prompted to 
ensure that “Delete” button was not clicked by mistake. If “Yes” button on the message box 
is clicked, the record deletion will be completed without any other warning. Clicking “No” will 
cancel the delete action.  

(vii) Export records 

All the selected and displayed records will be exported into text (csv) file that will be saved in 
a location and filename to be selected by the Climsoft user. 

Select the “Close” button to close entire dialog and “Help” button to get more help on the 
“Update Observations” procedures. 

 

 

8. Data Transfer Operations 

Data transfer involves the operations described below: 

(i) Upload: Transfers quality controlled data from the table “observationinitial” to 
“observationfinal”. More details in Section 7.2, 

(ii) External Data: Imports text data files in formats such as; CLICOM, Automatic Weather 
Station (AWS), NOAA GTS and any other text data in delimited texts files. Backup 
files from earlier Climsoft versions will also be imported through a process called 
“Data migration”. More details are given in Sections 8.1 through 8.5, 

(iii) Backup: Makes a backup of all data in table “observationfinal” to text files. More details in 
Section 9.1, 

(iv) Restore: Restores Climsoft version 4 backup files back to the database. More details in 
Section 9.2. 

8.1 Data from Climsoft V3 – Data migration 

From the Welcome dialog click on the icon “Data Transfer” then “External Data” and ”Data 
Migration” to obtain the dialog in Figure 50. 
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Figure 50: Data migration dialog 

8.1.1 Importing from Climsoft Version 3 MySQL Database 

This operation requires both Climsoft Version 3 database and Climsoft Version 4 database be 
installed in the same server.  

Data migration from V3 to V4 will then be carried out in the following steps; 

(i) Ensure the database names for both V3 and V4 are correctly typed (See Figure 50 above); 
(ii) Select the option “Entire Database” if the entire database is to be migrated, 
(iii)  Select the option “Selected Records” if only a range of data is to be migrated and 

provide the starting and the ending years appropriately, 
(iv) Check the box “Replace Existing Records” if any existing similar records are to be 

replaced. If Unchecked the duplicate records will be skipped, 
(v) Click Start command to start the process, 
(vi) Observe any message reported in the Messages box and address them accordingly. 

8.1.2 Importing from CLIMSOFT V3 Backup 

Climsoft Version 3 backup files archived in text (csv) files are imported through this operation.  

The steps to be followed are: 

(i) Select the option “Climsoft V3 Backup” (see Figure 50 above), 
(ii) Through the explorer button  select the text backup file. The file name is then displayed 

in the box “Backup File” but wait for the messages; “Climsoft V3 Backup converted to 
Climsoft V4 Structure”, 

(iii) Check or uncheck the box “Replace Existing Records” appropriately, 
(iv) Click “Start” command to start the process, 
(v) Observe any message reported in the Messages box and address them accordingly. 

8.2 Importing CLICOM data 

From this operation the three CLICOM data formats namely CLICOM Daily, CLICOM Synop and 
CLICOM Hourly will be imported into Climsoft version 4. 
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Figure 51 shows a screenshot of sample CLICOM daily data. The data format is similar to that 
for CLIMBASE. Users with data from CLIMBASE can follow the same procedure to import 
CLIMBASE data into CLIMSOFT. 

 
Figure 51: Sample CLICOM daily data 

To import CLICOM daily data, click on the “Data Transfer” icon on the Climsoft Welcome screen, 
followed by clicking on the menu items External Data ->CLICOM->Daily. This will open the 
dialog shown in Figure 52 below. 

 
Figure 52: Importing CLICOM daily data 

To import CLICOM daily data click “Open File” then select the file containing the data and click 
“Open” on the file open dialog. Enter the hour for the daily data observation in the text box 
“Default Observation hour”. 06Z has been set as the default. Then from the import dialog click 
“View Data” and the grid table gets populated with the data.  Confirm that it’s the right data and 
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then click “Load Data”. Wait for the process shown in Figure 53 to complete with a message 
“Data import process completed”. CLICOM Synop and CLICOM Hourly data are similarly imported. 

 
Figure 53: CLICOM daily data import process 
 

8.3 Importing Automatic Weather Station (AWS) data 

Before importing AWS data, it is important to note the structure of the AWS data file. Many 
Automatic Weather Stations (AWS) are configured to produce data output files in ASCII format. 
However, AWS systems from different suppliers tend to have different observation data outputs 
depending on the sensors available and configuration of the output file. Figure 54 shows a 
screenshot of sample data from an AWS site installed in Rwanda. The first row contains the field 
(column) headings representing different meteorological elements. In most cases, not all fields 
are required for data ingestion into Climsoft database. 

Figure 54: Sample observation data from an AWS 
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8.3.1 Selecting the import file and viewing the data 

Procedures: 

(i) Select the “Data Transfer” Icon from the main menu Welcome dialog, 

(ii) Select “External Data” form the Database utilities menu, 

(iii) Select “AWS” to open import dialog shown as shown in Figure 55, 

(iv) Click on “Open File” to browse for the file to import, 

(v) After the file has been located, click “Open” in the file open dialog. The filename with its 
full path will then be shown in the Import File text box. See Figure 55, 

(vi) Select the “Delimiter” option that matches the data separator in the selected file. 
Selecting a wrong delimiter option will result in data not being properly imported. If data 
the delimiter is neither Comma nor Tab the click on the option Other and type the 
delimiter character e.g. “;” for semicolon. 

(vii) If some header rows are to be skipped while importing then, enter the row number where 
importing will start in the box “Start Row”. (Start Row: 2 is the default i.e. data starts at 
row 2 when it is  only row 1 that contains headers for the data columns), 

(viii) “Remove Scaling” is checked by default i.e. if data in the file has been scaled to some 
decimal points then the decimal point will be removed during the transfer into 
“observationinitial” table. If the data in the file is not scaled to decimal points then the 
“Remove Scaling” box should be unchecked. 

(ix) If all the data belongs to one station and that it does not have a column with station 
IDs, then type the ID for the station in the box “Station ID”, 

(x) After completing above steps click “View Data” to populate the grid view with the 
selected data. Note that only the first 100 rows of data from the selected file will be 
displayed in the grid table. This is meant enable viewing to confirm that the right data 
has been selected. However, the entire file will be imported if everything is well 
selected. 

Note that the column headers in the grid table will be serialized with numbers from 1 up to 
the last column of that data. The following section outlines how to rename the column 
headers with the element codes for the observations they represent. 
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Figure 55: AWS Data Import 

8.3.2 Configuring column headers and uploading data into Climsoft database 

(i) Under “Columns Header Settings”, select the column number and the field name that 
describes data in that column. Do that for each column until all of them are done. Make sure 
the correct field names are selected in order for the data to be appropriately mapped into 
the database. If any column contains data that does noon need to be imported then “NA” 
should be selected for field name. See Figure 55, 

(ii) If the step (i) above is correctively completed, then the configured header specifications can 
be saved in a text file to be used later in importing a similar file without going through that 
process again. To save the specifications click “Save Header Specs” button and choose a 
convenient location (i.e. folder) and filename. Note that the file will be automatically allocated 
file extension of sch e.g. aws1.csh and the file with its path displayed below that button. See 
Figure 56, 

(iii) If the header specs had been saved earlier click “Load Header Specs” and select the 
header specs file. If correctly selected the columns in the displayed data table will be 
automatically labeled with the header specs. Note that after the header specs file has been 
save or loaded, the button “Load Data” becomes enabled. 

If satisfied that the columns are correctly named and the button “Load Data” is enable then 
click it to start the uploading process. Wait until the busy mouse pointer changes to default. A 
message will be displaying at the bottom of the dialog in red showing the data transfer progress. 

It should be noted that station IDs and element codes used must described in the metadata. If 
not, data described by them will not be imported. Station IDs and Element Codes not found in 
metadata will be listed at the bottom of the dialog. 
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 Figure 56: Configured column headers 
 

8.4 Importing data from text files with different structures 

8.4.1 Hourly and Daily Data Import 

Daily/Hourly observation values arranged in one or many columns can be ingested easily into 
Climsoft version 4. The data should be in delimited text files. Figure 57 and 58 are sample data 
files with data organized in different structures: 

 
Figure 57: Sample file with observations in one column labeled G 
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Figure 58: Sample file with observations in many columns starting at column E (day 1) 

 

Follow the steps below to transfer Hourly/Daily data with one or many columns structure into 
Climsoft version 4: 

(i) Select “Data transfer” icon from the Welcome form, 
(ii) Select “External Data” and select “Text Files” and then “Hourly or Daily” option, Figure 

59, 

 

 
Figure 59: Import External Data Dialog 

(iii) After selecting “Hourly or Daily”, the dialog in Figure 60 opens up. Click on “Open File“ 
to browse and select the file containing data to transfer, specify the “delimiter” of the file 
to import e.g. comma (default), TAB or Others (type in the delimiter character). 
Check/uncheck the “remove scaling” box appropriately to ensure data is imported into 
“observationinitial” table without the decimal points. Click “View Data” button to view the 
data in a grid view (tabular form), 

(iv) Set the column headers by matching each data column by its corresponding field name 
then click the button “Save Header Specs” to have the dialog shown in Figure 61, 
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Figure 60: Importing Hourly Data 

 
 

 
Figure 61: Columns Header Settings 
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(v) Click the “Load Data” button to load the data into the “observationinitial” table. Then 
observe the records uploading count and finally the process completion message at the 
bottom of the dialog. In case the upload fails a message will pop up accordingly. 

Note: To avoid setting the columns headers each time a similar file is to be imported, save the 
columns header specifications by selecting the “Save Header Specs” button. Note the file 
extension (e.g. header1_specs.sch). 

To retrieve and use the saved columns headers click the ” Load Header Specs” button and 
navigate to select the appropriate file. 

8.4.2 Multiple Element Columns 

Figure 62 shows a text (csv) file (opened in Excel) with 4 columns for StationID, Year, Month, Day 
and 5 columns for values of different Elements namely. Tmax, Tmin, RAIN, RAD and EVAP. This file 
can be easily imported in Climsoft V4 through the procedure described below: 

 
Figure 62: Sample data with multiple columns 

The procedure to import this file is as follows: 

a) Selecting the import file and viewing the data 
(i) Select the “Data transfer” icon from the welcome dialog, 
(ii) Select “External Data”, then “Text Files” followed by “Multiple Element Columns” as 

shown in Figure 59,  
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(iii) Select Open File to browse the file to import, 
(iv)  After the file has been located, click Open in the file open dialog. The filename with its 

path will then be shown in the “Open File” box. See Figure 63, 
(v)  Select the Delimiter option according to the data separator for the selected file (comma, 

tab or others). 
(vi) If some rows are to be skipped while importing e.g. column headers then enter the row 

number where importing will start in the “Start Row” box. Row 2 is the default which is 
also the case in this example, 

(vii) If the data does not contain the observation hour column, fill the “Default Observation 
Hour” box with the hour used for the daily data. The value 06 has been set as default as 
it is the case with most observations, 

(viii) If the data in the file is scaled to some decimal points, then ensure the box “Remove 
Scaling” is checked, 

(ix) When all the above steps have been completed click “View Data” button. The table in 
the dialog is then populated with the data from the selected file. The column headers will 
be serialised with numbers from 1 up to the last column of that data, as shown in Figure63. 

(x)  

 
Figure 63: Multiple column data Import 

 

b) Configuring column headers and uploading the data 

(i) Under “Columns Header Settings”, select the column number then click on the 
corresponding field name from the list box. For the data columns, the selected field name 
should be the element code for that data. Repeat for each column. Make sure the correct 
field names are selected in order for the data to be appropriately mapped in the database, 
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(ii) Once step (i) is completed, the created header specifications can be saved in a text file 
to be used later for a similar file without going through the same process again. To save 
the header specifications follow the procedure described in Section 8.3.2 (ii) above, 

(iii) If the header specs had earlier been saved then click “Load Header Specs” and select 
the file containing those header specs. If the correct file is selected, the columns for the 
displayed data table are labelled automatically as shown in Figure 64, 

(iv) Once the columns are correctly named click “Load Data” to start the uploading process. 
Wait until the busy mouse pointer changes to the default. A message is then displaying 
at the bottom of the dialog in red showing the data transfer progress. 

More details on the Command buttons for the data import dialog are as follows: 

Save Header Specs - To save the created header specification to a file for future use; 
Load Header Specs - To load header specification that had been saved for a file with the same 

structure; 
View Data - To view data from the selected file in a table view; 
Load Data – To start data uploading process from the selected text file to the “observationinitial” 

table;  
Clear – To clear the grid view of the displayed data; 
Close - To close the dialog;  
Help - Click Help to get more information on the dialog; 

 
Figure 64: Multiple column data Import with column headers specification 
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8.5 Importing Summarized Data 

Data that is summarized on Dekadal or monthly basis can be imported into Climsoft. In practice 
this is done when the raw data for those summaries is not available. Otherwise it is advisable to 
import the actual observation values because Climsoft is capable of producing those summaries 
whenever required. After importing, the summarized values will be placed in the appropriate day 
of the month and then allocated a period value that is equivalent to the number of days used in 
the summary. For instance, monthly summary values will be placed on the last day of the month 
and the period value will be the number of days in that month. 

Following are examples of the summarized data with layouts: 

        
Figure 64a Dekadal data – Multiple Elements columns  Figure 64b Dekadal data– Single Element column 

    
Figure 64c Monthly data– Multiple Elements columns  Figure 64d Monthly data – Single Element column 

The import procedures will depend on the layout of the summarized data as follows: 

(viii) Data in multiple Elements Columns - Figure 64a and 64c 

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Multiple Element Columns. Then check the option 
Dekadal or Monthly for type of Figure 64a or 64c respectively. 

 

(ix)  Dekadal data in single Elements Column - Figure 64b  

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Daily. Then check option “Dekadal”. 
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(x) Monthly data in single Elements Column - Figure 64d  

From Welcome dialog follow: 
Data Transfer -> External Data ->Text File->Monthly. 
 

Notes on Daily Data Import 
Trace Rainfall – Should be typed as 0T 
Missing Data – Should be left as blank. Any value that is not numeric will be regarded as missing data. 
Cumulated data – Cumulated data should be type with C e.g. 200C. Values for preceding days should be left 
blanks. 

8.6 Importing Upper Air data 

Importing procedures for upper air data that has been digitized through other applications and 
archived in delimited text files is similar to the files with surface observations data. The 
appropriate menus will be used depending on the layout of data in the files. The suitable menus 
are those for daily or multiple columns for elements. The only additional procedure is to indicate 
that the file contains upper air data by checking the box; Upper Air Data and entering date and 
time the balloon was launched in the format given. See Figure 64e below. 

 

 Figure 64e: Multiple element columns data Import for upper air data file 

8.7 Upload failures 

The data upload process may fail due to various reasons. Error messages will be given in each 
case. As much as possible the messages should be studied carefully and the problems 
described therein addressed. In case of station or element in the data that had not been defined 
in the metadata the affected records will be skipped then their stations/elements are listed at the 
bottom of the import dialog. The data should therefore be corrected accordingly and reloaded. 
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8.8 Importing GTS data downloaded from NOAA – NCEI 

The NOAA-NCEI site has a huge archive of GTS daily observation data from all synoptic stations 
around the globe. Most of the data dates back to the early 1970s. The data goes through some 
QC at NOAA-NCEI and is updated on a daily basis. Data in this site is organized in summaries 
for different range of time and put in different datasets. The dataset for daily data that is suitable 
for Climsoft import is called Global Surface Summary of the Day (GSOD) 

The data is publicly available in text (csv) files. Climsoft is able to import these files through the 
external data import dialog. Figure 65 below shows a screenshot of sample data downloaded 
from the NOAA-NCEI site: 

 

Figure 65: Sample data from NOAA-NCDC 

To import GTS daily data from NOAA-NCEI; 

(i) Select “Data Transfer” icon on the CLIMSOFT Welcome screen,  
(ii) Select “External Data” menu; 
(iii) Select “NOAA GTS” to open the dialog and browse the data file as shown in Figure 66 below. 

https://www.ncei.noaa.gov/access/search/data-search/global-summary-of-the-day
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Figure 66: Importing data from a text file downloaded from NOAA-NCEI site 

Notes on NOAA-NCEI data:  

b) Since the GTS data would have gone through QC at NOAA-NCEI, it may be transferred 
straight to the “observationfinal” table. However, if it is desired to be subjected to QC 
again then it should be transferred to the “observationinitial” table by checking on the 
option “Observation Final”. 

c) The required data can be downloaded from the site: 
https://www.ncei.noaa.gov/access/search/dataset-search 

8.9 Selecting Station and Element on the Import Dialog 

Where Station and/or Element columns are missing in the file to be imported they should be 
provided in the import dialog.  They are selected from Station and Element list boxes accordingly. 
These boxes allow selection by station and element names or by entering the station id or 
element code the press Enter Key respectively. See Figure 6a 

 
Figure 66a: Stations and Element Selection 

https://www.ncei.noaa.gov/access/search/dataset-search
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9. Data Backup and Restore 
Data backup and restore are essential operations in data management.  

9.1 Data Backup 

9.1.1 Data backup by station 

Climsoft Version 4 has a facility for a complete backup of all the observation data in the 
“observationfinal” table by making individual backup files for each station. 

This process is fast and minimizes the computer memory resources. In addition it provides a 
quick view of the list of backup files in Windows File Explorer with the relative amount of data for 
each station by examining the file sizes, without the extra effort of doing a detailed inventory 
report (Figure 67). 

 
Figure 67: List of individual station backup files 
 

The backup dialog shown in Figure 68 is accessed by clicking the “Data Transfer” icon on the 
Welcome screen, followed by clicking the menu item “Backup”. 

     
Figure 68: Data backup 
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Browsing for the backup folder from the database server, then click the “Backup” button, for the 
backup process to start. The progress of the backup process is displayed.  

9.1.2 Complete database backup 

In Climsoft Version 4, the recommended tool for backing up of the whole database is HeidiSQL.  
This is a graphical interface for managing databases that comes bundled with the MariaDB 
DBMS installation. HeidiSQL is easy to configure and use. 

Launch HeidiSQL either from the desktop shortcut or from the Windows Start menu under 
MariaDB program group. This displays the “Session Manager” as shown in Figure 69. 

  
Figure 69: HeidiSQL Session Manager           

The Session Manager in Figure 62 is to configure a connection to the MariaDB server. To setup 
a new connection, click on the “New” button on the bottom left corner of the dialog; 

After editing the “Session” name on the left panel of the dialog, specify the connection details 
on the right panel of the dialog. The required details include the IP address of the computer 
(server) where MariaDB is installed, the Port number, the user name and password. 

The Session Manager allows configuration of connections to more than one MariaDB installation 
on different computers. If MariaDB is installed on the local computer then the IP address should 
be “127.0.0.1” or “localhost” as shown in Figure 69. 

Completing the required connection details then clicking the “Open” button (Figure 69), a screen 
appears with details of the database(s) and objects for the specified Port number, Figure 70. 
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Figure 70: HeidiSQL interface showing database information 

To carry out a complete backup of a required database, right click on the database name on the 
left panel of the dialog in Figure 70; 

A pop-up menu appears, click on the menu item “Export database as SQL”; this displays a new 
dialog to specify details for the backup as shown on Figure71. 

Figure 71: HeidiSQL Dialog for database backup 

Click on the icon to the right of the filename to browse for the location and specify the filename 
for the backup.  
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To create a new database structure with all the tables and data, check all the boxes on the right 
panel and select “INSERT” on the “Data” dropdown list. 

Click the “Export” button, then backup process starts and saves the backup file with the specified 
name (and the extension .sql), in the specified location. 

To restore the database (script file) click on “File” then “Load SQL file…”. Select the backup 
script file then click “Open” on windows explorer dialog and follow the subsequent dialogs. 

9.2 Data restore 

9.2.1 Data restore by Station  

The dialog for restoring data from individual station backup files is shown in Figure 72. This is 
accessed by clicking the icon “Data Transfer” on the Welcome screen followed by clicking on 
the menu item “Restore”. 

 
Figure 72: Data restore 

Browsing for the backup folder, then click the “Restore” button. The data restore process 
starts, showing the progress of the restore process. 

9.2.2 Complete Database Restore 

To recreate and restore the entire database from a complete backup, run the script of the backup 
file following the steps similar to those for creating a new database in MariaDB as described 
under Topic 2, section 2.3 (Creating Climsoft Database in MariaDB and First Login). It is 
important to specify the exact name of the backup file in place of the name of the script file used 
for creating Climsoft Version 4 database at the first installation. 
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10. Climate Products 

10.1 Standard Products 

Climsoft version 4 provides a number of standard products which produce commonly required 
reports or diagrams using data contained in the “observationfinal” table. Products are obtained 
as follows. 

From the Welcome Dialog, click on the icon Climate Products or select Products on the main 
menu. The resulting dialog is shown in Figure 73. 

 
Figure 73: Products category list 

The categories of the products are listed after clicking on the list box. When a product category 
is selected then all products under that category are then listed.  

For instance if category Data is selected, the products list under that category will be as shown 
in Figure 74; 
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Figure 74: Data Product list 

Details of different products type are listed in Table 3; 

No Products 
Category 

Product Types Details 

 
 

Data Minute Minutes observations 

Hourly Summary of hourly observations 

Daily Summary of daily observations 

Pentad 5 Days summary 

Dekadal 10 Days summary 

Monthly Monthly summaries 

Annual Annual summaries 

Means Long term means 

Extremes Long term extremes (i.e. highest, lowest, dates of occurrences) 

Daily Extremes Daily Lowest and Highest values 

Monthly Extremes Monthly Lowest and Highest values 

Annual Extremes Annual Lowest and Highest values 

Seasonal Monthly Monthly Seasonal Summaries 

Daily Wind Speed Wind Speed from Daily Wind Run Total 

Hourly Wind Speed Wind Speed from Hourly Wind Run Total 

 Graphics Windrose Windrose picture 

TimeSeries Time Series Chart 

Histograms Histograms Chart 

 Inventory Inventory  Details of Data Records 

Missing Data Inventory of Missing Data 

Stations Records Time Series Chart for  total Observing Stations 

Yearly Elements Observed Yearly Time Series Chart per Station 

Monthly Elements Observed Monthly Time Series Chart per Station 

 Messages CLIMAT CLIMAT Messages 

 Output for other 
Applications 

Instat Daily data for Instat 

Rclimdex Daily data for Rclimdex 

CPT Data for CPT 

GeoCLIM Monthly Monthly Data for GeoCLIM 
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No Products 
Category 

Product Types Details 

GeoCLIM Dekadal Dekadal Data for Geoclim 

GeoCLIM Daily Daily Data for Geoclim 

CDT Dekadal Dekadal Data for CDT 

CDT Daily Daily Data for CDT 

Climate Station Data for Climate Station Tool 

 Rain Days Dekadal, Monthly and Annual Counts of rain days with a specified threshold value 

 Upper Air Daily, Monthly and Annual Summaries for upper air observations at standard levels 

 Special Products Mean Water Level Hydrological Mean Water Level 

Table 3: Climate Products. 

 

Once the product type is selected, a dialog appears from where details of the desired product 
are specified. For instance if Monthly product is selected the dialog obtained is as shown in 
Figure 75. 

 
Figure 75: Data selection dialog 
 

The Station (s) and Element (s) are selected from the respective list boxes each one at a time. 
Deletion of undesired selections can be carried out for one item or the entire list using the 
commands provided at the bottom of each box. 

The relevant Summary Type and Period are then selected. The command “Start Extraction” 
is used to produce the selected product. 

The Period specifies the time range for the selected product. Default period is from 01/01/2000 
to the current date. 

The “Transpose Values” box if checked, the products will be displayed in a horizontal layout 
where date components (days, dekads or months) become the column headers for the data 
values. 
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The “Advanced Products Select” box if checked, a set of stations under a specified group are 
selected and listed on the Stations panel. All those stations will then be included in the extracted 
product. The station groups are based on the metadata descriptions such as; Type (Qualifier), 
Authority, Admin region, Drainage basin and a specified Geographical location. For instance if 
under the Qualifier option SYNOPTIC is selected then all synoptic stations will automatically 
selected and listed on the Station view box 

Figures 76(a), 76(b), 76(c) and 76(d) below give examples of data products output; 

 
Monthly TMax and TMin 

 
Figure 76(a): Monthly products 
 

Extreme Values 

Figure 76(b): Extreme Values  
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Extreme Maximum Values  

  
Figure 76(c): Extreme Maximum Values and Date of Occurrence 
 

Extreme Minimum Values  

 
Figure 76(d): Extreme Minimum Values and Date of Occurrence 
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10.2 Data Products for Other Applications 

10.2.1 Data for CPT 

 
 Figure 77: Output data for CPT 

10.2.2 Data for GEOCLIM 

 
Figure 78: Output data for GEOCLIM 



 77 

10.2.3 Data for Instat 

 
Figure 79: Output data for Instat 

10.2.4 Data for Rclimdex 

 
Figure 80: Output data for Rclimdex 
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10.3 Windrose Plot 

Windrose is plotted after selecting “Graphics” from the list of climate products category shown 
in Figure 73 above; 

The next step is to choose “Windrose” from the list, followed by the station. It is recommended 
that only one station is selected for each windrose plot. The system selects the wind speed and 
direction elements automatically. Specify the period range for the data to be used for the 
windrose plot.  
Click “Start Extraction” to generate the windrose plot as shown in Figure 81. 

Before the windrose picture is generated, a message props up with the question, “Is the wind data 

from AWS?” This is because wind data from AWS has a different element code from that of 
manned station. 

Climsoft uses a third party application called WRPLot to produce the windrose picture.  This 
application is a free software but requires a licence that must be renewed annually. 

It is important to check that WRPLot was installed as part of the Climsoft installation and the 
licence for the application was registered. If WRPlot has not yet been installed, it can be installed 
using the setup file and the first licence file available in the “Bin” subfolder of the Climsoft 
installation folder.  

To renew the license visit the Lakes Environmental website at 
https://www.weblakes.com/products/wrplot/registration.html. Once you register your details and 
apply for the activation code, it will be sent to your email shortly. 

 
Figure 81: Windrose plot  
 

https://www.weblakes.com/products/wrplot/registration.html.
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10.4 Plotting Charts 

Simple and basic charts can be plotted through the charts menu. There are two types of charts 
that can be produced namely, Time Series and Histograms. 
The charts are produced through the same procedures used in other products. It is 
recommended that each chart be plotted for data from 1 station only. 
After Extracting data required for the chart, a plotting dialog will be displayed from where the 
required chart details can be provided. 

    
Figure 82: Charts Plotting Dialog 

 
For example to plot a Histogram chart, for monthly temperatures (Tmax and Tmin) from Wilson 
Airport, Kenya for the year 1988 do the following: 

(i) Select the option Monthly, 
(ii) Click the button Plot and obtain the chart below. 
(iii) The plotted chart can be formatted for Labels, Colours and Axis Interval values as 

shown in Figure 83. 

 
Figure 83: Temperatures Histograms 
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Similarly a Histogram chart for daily rainfall from Wilson Airport, Kenya for the period 2005-
2014 can be plotted as below. 

 
Figure 84: Rainfall Histogram 
 

Managing the Chart dialog 

In order to have a presentable chart that can be used in the intended purposes, the following formatting 

can be done: 

Labels 

Labels that clearly describe the chart should be typed in the correct boxes. They will appear on the chart 

area as the typing continuous; 

Series colours 

Clicking on any of the listed series names a colour palate dialog appears from where a suitable colour 

can be selected. 

Axis Intervals 

The suitable intervals for both X-Axis and Y-Axis should be entered into the appropriate boxes so that 

the data is clearly interpreted. 

Commands 

Save - Saves the chart picture as a file in the desired graphic format e.g., JPEG, PNG, WMF etc. 

Print -Prints the chart picture through the default printer, 

View data – Click to view and export the data used in plotting the chart 

Help - Click to learn more about the current chart, 

Close – Closes the dialog 
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10.5 Inventory Products 

The inventory product retrieves details of the climatic elements that have been recorded at a 
particular station. When you click on the menu item Products -> Inventory or the icon 
Climate Products -> Inventory on the Welcome dialog, the following dialog is displayed: 
 

 
Figure 85: Inventory Products dialog 

 

There are 5 types of outputs that can be obtained from the Inventory product. They are;  

(i) Details of Data Records - Gives a tabulated output where a missing observation is 
represented by M and available observation by X. The procedure searches the database 
for the appropriate information and produces an Excel Spreadsheet as shown in Figure 87. 

(ii) Inventory of Missing Data – Gives the total number of missing observation records for a 
selected parameter in a given period of time. The output is displayed in graphical form as 
shown in Figure 87a. 

(iii) Time Series Chart for Observing Stations – Produces a time series chart for yearly total 
stations whose data has been archived in the database as shown in Figure 87b. 

(iv) Yearly Elements Observed – Produces a time series chart for total observations per year 
for the selected elements from a given station. See Figure 87c 

(v) Monthly Elements Observed – Produces a time series chart for total observations per 
month for the selected elements from a given station. See Figure 87d. 

To produce any of these inventories select the required station(s) and element(s) from their 
respective list boxes as shown in Figure 87e.  
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Figure 86: Input selection dialog for Inventory Products 
 
 

 
Figure 87: Inventory of Data Records 
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Figure 87a: Total missing data records 
 

 
Figure 87b: Total annual reporting stations  
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Figure 87c: Total annual observed station elements  
 

 
Figure 87d: Monthly observed station elements 

10.6 Products from Upper Air Observations 

Dialog for products from Upper Air observations is obtained as follows: 
 
From the Welcome Dialog, click on the icon Climate Products or select Products on the 
main menu to obtain the products category dialog as shown in Figure 73. From the listed 
items Click on Upper Air to obtain the list of the available Upper Air data summaries as 
shown in Figure 88. 
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Figure 88: List of Upper Air data summaries 

 

If any of listed products say Monthly Levels is selected (click) the following dialog is obtained. 

 
Figure 88a: Dialog for Monthly Upper Air data summaries  

The dialog shown in Figure 88a is similar to those for surface observations but with an 
additional list of upper air standard pressure levels. Any number of levels may be selected as 
necessary. 

Note that without selecting any Level no product will be obtained. 

10.7 CLIMAT Messages 

CLIMAT message can be encoded from quality controlled data that has been uploaded to the 
final table of Climsoft database. 

Dialog for encoding CLIMAT messages is obtained as follows: 
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From the Welcome dialog follow the menu 

Climate Products => Messages => CLIMAT. The dialog shown in Figure 88b is then 
obtained  

 
Figure 88b: Dialog for encoding CLIMAT message 
 
The dialog is used as follows: 

(i) Select Stations – Stations whose CLIMAT message is required should be selected from 
the drop down list by clicking one station at a time. A station can also be selected by 
entering its station id then pressing ENTER key. The selected stations will be listed in the 
view list. Note that only stations with WMO identifications will be available for selection. 

(ii) CLIMAT message period –When the dialog opens the period is set to the previous month 
of the current date. It is assumed that data for the previous month has been processed and 
ready for encoding. However, month for the required message should be correctly set. 

(iii) Climate statistics base period– Begin Year and End Year of the period with suffient data 
to compute the climate statistics should be entered. A minimum of 30 years and the latest 
period defined by WMO is recommended. On Clicking OK button the statistics for the 
selected period will be computed and stored in the database. It’s not necessary to compute 
them again unless base period has been updated. 

(iv) Optional Sections – If required any of these sections can be included in the message 
when selected. Note Section 222 requires that suffient data to compute normals for the 
specified base period is available. 

(v) Command buttons 

i. Encode CLIMAT – Starts the encoding process according to the selections made. 
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ii. Clear – Clears all the input including the produced CLIMAT message 

iii. Close – Closes the dialog 

iv. Send – Sends the the encoded message to the message switching server for GTS transmission.  

v. Help – Gives a guide on how to use the dialog 

vi. Settings – Opens the dialog through where the required settings for CLIMAT message encoding 
are done. Only users with administrative privilleges can open and operate the Settings dialog 

(vi) CLIMAT Message File – Encoded CLIMAT message will be saved in the indicated file. It’s 
a text file that can be sent via email as an attachement or its text copied and pasted into 
the message body of and email. 

(vii) CLIMAT message encoding settings – The Settings button opens the Settings dialog as 
shown in Figure 88c. The dialog has two tabs; Paremeter and FTP for setting the element 
codes for data used in CLIMAT encoding and details of the server where the mesage will 
be sent respectively. The dialogs for these settings are easy to follow 

 
Figure 88c: CLIMAT message Parameters (elements) settings 

 

 
Figure 88d: CLIMAT message FTP settings 
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11. AWS Real Time Data Operations 
 

This operation starts from the Welcome form dialog. Click the icon AWS Real Time Processing 
to obtain the main dialog for Real Time Automatic Weather Station (AWS) data operations 
(Figure 89). 

 

 
Figure 89: AWS real time processing settings dialog 

Follow the steps below to configure Climsoft for automatic processing AWS data. 

11.1 Server Settings 

Click the command “Servers” then Base Station tab to obtain dialog shown in Figure 90. 
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Figure 90: AWS server settings 

These settings are for the servers that play the roles of AWS base station and message 
switching system that connects to the Global Telecommunication System (GTS). The 
commands “Base Station” and “Message Switching” are used to switch between the two 
server settings. Details required should be obtained from the respective servers’ administrators 
and then entered. Multiple servers can be configured where AWS sites are connected to different 
base station servers.  

Click Save to effect the changes.  

The details should be entered as follows; 

FTP Server Address – The FTP address e.g. 40.73.196.133 or the server network name; 

Input Folder: 

This is the subfolder in the FTP home directory of the server where data are located in the case 
of the AWS base station or where it will be copied to in the message switching system. If the 
subfolder is not in the root, the relative path should be indicated in according to the operating 
system rules. For example; AWS\input in windows and AWS/input in Unix/Linux; 

FTP Data Transfer Mode 

This is the login method allowed for data transfer by the target server. MS Windows based 
servers allow use of FTP. Some Linux based servers prefer the use of more secure data transfer 
methods such as SFTP. The method indicated by the target server should be entered here; 

User Name – Login name used to logon into the server, 

Password – Password for the user name provided, 

Confirm Password – The entered password to be confirmed. The Password is not saved until 
correctly confirmed. 
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11.2 Sites Settings 

The stations whose data is to be processed are configured as follows; 

 Click the command Sites to give the dialog in Figure 91, 

 

Figure 91: AWS server settings 

 

Site details:         

 Site ID or Name as provided by the Met Service or obtained from WMO Vol A if already 
listed there, 

 Input Data file is the name of text file in the AWS base station containing data for the 
station listed in that current record. It should be ensured that the name matches the station’s 
AWS data file, 

 Files name prefix if the data is in multiple files with a common prefix, the box before the 
“File name prefix” should be checked and the prefix filled in the text box. Otherwise, this 
should not be checked. 
In some special cases where filenames have date components, a date structured file name 
prefix may be used to select files with observations for a day, month or year. For instance 
for a date structured filename such as 000001202008290000.txt the prefix will be entered as 
follows: 

yyyymmdd – To select all files for the current day’s observations 
yyyymm – To select all files for the current month’s observations 
yyyy – To select all files for the current year’s observations 

For a filename such as 000001-2020-08-29-00-00.txt the prefix will be entered as follows: 

yyyy-mm-dd – To select all files for the current day’s observations 
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yyyy-mm – To select all files for the current month’s observations 
yyyy – To select all files for the current year’s observations 

 Data Structure is the name of the structure for the data output file in the AWS base station 
server. This is created by the user and should correspond to the data being transferred. 
Details on how to undertake this task are listed in Section 11.3.2, 

 Missing Data Flag is the value that represents missing data from the specified AWS 
server. This value will be obtained from files in the base station server; 

 AWS Server IP is the IP address or host name of the server; 

 GTS Msg Header is the Global Telecommunication System message header (e.g. HKNC 
for Nairobi) in case AWS Data are meant for sharing with others countries through the  
regional or global centres, 

 Operational if a site has been created in the Climsoft database but has no operational 
AWS installed the box Operational should be unchecked, 

 Encode for GTS if a site has been created in the Climsoft database but does not send 
AWS to GTS, the box Encode for GTS should be unchecked. 

Commands: 

 To create new station in the database click Add New, enter all the details then click 
Refresh,  

 Update is used to save changes made on the details of an existing station, 

 Delete is used to remove the current station from the database, 

 View/Update enables viewing the sites in a table view. Editing can be done from there. 

11.3 Data Structure Settings 

Click the command Data Structures to obtain the dialog for updating or adding new AWS data 
structures used by Climsoft. 

Select any of the existing data structures e.g. aws_toa5_mg2 from the list box. Details of that 
structure are displayed as shown in Figure 92. Any desired changes will be done on the table. 
The changes made will be saved automatically. 
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Figure 92: AWS data structure settings 

To carry out the task of data structure settings, basic skills in BUFR and Climsoft elements are 
necessary. Configuration of the data structure is done as follows; 

11.4 Updating existing structures 

Changes can be made as may be desired. Real time processing of AWS data is based on 
structure of the data.  

This includes; 

(iv) Updating Bufr_Element – Only those elements whose BUFR element descriptors are 
entered will be encoded into BUFR messages. In case a new sensor is added and new 
observation started, its BUFR descriptor should be included. BUFR descriptors can be 
found in WMO BUFR Table B, 

(v) Updating Climsoft_Element – If an observation from any AWS element requires to be 
archived in Climsoft database, its Climsoft element code should be included. Climsoft 
element codes are contained in obselement table in the Climsoft database, 

(vi) Adding observation elements (record) 

To add a new element (a new sensor may be installed or activated) in the same structure, 
scroll on the table to the end of list and enter the details in the blank record. The values will 
be saved automatically, 

(vii) Delete Record 

Select the record by clicking at the left most cell of the record. It will become highlighted. 
Then press Delete key on the keyboard. The record will be deleted without any warning. 
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(ix) Structure Name, Delimiter Type, Total Header Rows and Text Qualifier Character 
may also be updated where necessary. In this case click Update to save changes. 

11.5 Creating a new structure 

Data from different AWS sites may come with different file structures. All the different data 
structures should be created in Climsoft and allocated a name so that the received data is 
correctly mapped in the database. After studying the structure of a data file from a given site it 
is easy to create its structure in Climsoft as follows; 

Study and understand the new AWS input text file. Suggest an appropriate name for the new 
structure then enter the details in the text boxes in Figure 93 as follows; 

(xi) Structure Name – Name under which the structure will be known, 
(xii) Delimiter Type – The character that separates data values e.g., Tab, comma etc. Select 

from the list, 
(xiii) Total Header Rows – The number of header rows above the observation values, 
(xiv) Text Qualifier Character – Where a character is used to qualify text values e.g. “, then 

it should be entered here. 

Click the command button Create. A table is then displayed as shown in Figure 90a, from where 
details for the data columns in the AWS input file can be entered. 

 
Figure 93a: Dialog for creating a data structure 

Enter the necessary details in the table. Details of each data column in the input file should be 
entered as a record (row) in the table. The first column should have value 1 in field Cols. All the 
details of the data should be entered in the different fields of that record (row). The next row 
should similarly start with value 2 in the field Cols. This procedure is followed until each column 
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of the data from the output text file is described in this table. Information required in each record 
is as follows; 

 Cols - Position (1,2…) of the column (from the left side) describing the data in the file, 

 Element_abbreviation – Abbreviation for the name describing data in the column.  

Users are free to use any abbreviation that conveniently describes the data except for the 
column with date and time values. The following abbreviations SHOULD be strictly used 
while abbreviating the date and time in the circumstances described below; 

Date/time - Date and time are in one column e.g. 21/03/2000 12:30:00 

Date - Date is in a column of its own e.g. 21/03/2000. 
Time - Time is in different column from Date e.g 12:30:00 
yyyy - Year is in a column of its own e.g. 2000 
mm - Month is in a column of its own e.g.03 
dd - Day is in a column of its own e.g.21 
hh - Hour is in a column of its own e.g.12 
nn - Minute is in a column of its own e.g.30 
ss - Second is in a column of its own e.g.00 
yyyymmddhhnnss -Date and time has this structure e.g. 20000321123000 
ddmmyyyyhhnnss -Date and time has this structure e.g. 21032000123000  
 

 Element Name – An appropriate name should be entered, 

 Climsoft_Element and Bufr_Element to correspond with the Climsoft and BUFR 
Element codes as described in their manuals respectively. Where no value is put in these 
fields, data in the affected column will not be processed for Climsoft archival or TDCF 
encoding accordingly.  

 Unit – This is the unit of measurement of the values in the column. If the unit cannot be 
determined, it is left blank, 

 Lower_Limit and Upper_Limit – These values are used for Quality Control purposes so 
that Climsoft can flag outlier values for confirmation at a later time, 

 Obsv – Nothing to be entered in this field. It is used by Climsoft when processing the 
observation data. 

Figure 93b shows data from an AWS text output file whose format is CSV with the character “, 
as the text data qualifier. 
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Figure 93b: AWS Output Text File 

11.6 Coding Settings 

 
Figure 94: Dialog for setting TDCF message parameters 

The dialog in Figure 94 shows the settings required in BUFR message encoding. Most of the 
default values are automatically set at installation, but some are set by the user to meet the 
requirements for a particular NMHS. To undertake these settings knowledge of Table Driven 
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Code Forms (TDCF) is necessary. WMO Manual on Codes is the main reference used for 
setting up the values here. 

11.7 Data Acquisition and Processing Dialog 

 
Figure 95: Dialog for Data Acquisition and processing 

 

The AWS data processing is controlled from the dialog shown in Figure 95 and the information 
on the processing status is displayed. Before the process is started it is important that the user 
understands the role of each control shown in the dialog. Details are as follows; 

Controls Details 

 Settings: 

o Restart – Starts/Restarts the processing schedule, 

o Stop – Stops the processing schedule, 

o Retrieval Intervals – The frequency in minutes at which data will be retrieved from 
AWS server and processed. Where encoding is required for Synoptic messages the 
interval will be entered as 180 minutes. 

o Hour Offset – Time delay in minutes to start encoding after the time set for data 
downloading from AWS data logger, 

o Timeout Period – The longest period in seconds that attempts to connect to the AWS 
server can be made before timing out the connection. If no time out period is desired a 
value of 999 should be entered. But in that case there is a risk of holding the process 
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indefinitely if connection is not achieved at all. If connection speed is the cause of the 
delay then a reasonable time out period should be entered e.g. 60 seconds. 

o Delete Input File After Processing - When checked, the files containing AWS data, 
will be deleted from the base AWS server after processing, 

o GMT Diff +/- – The time difference between GMT and the time for the AWS data. A 
positive difference may not require entering a + sign but a negative one is mandatory, 

o Save Changes – Updates the changes made. 

 Processing information 

o Input FTP Server - AWS Base station from where data is retrieved for processing, 
o Input Files – List of the retrieved AWS text files, 
o Output FTP Server– Message Switching System to where encoded messages have 

been sent, 
o Output Folder – Folder containing output files, 
o Message Files – List of the encoded and transmitted files. 

 Processing Status 

o Current Date and Time – Computer clock time. It should always be correctly set, 

o Retrieve last – Hours of data to be retrieved for encoding at each encoding interval, 

o Last Processed – Date and time of the previous encoding process, 

o Next Processing – Date and Time of the next encoding process, 

o Status – The current activity.  

 Error Messages 

Errors encountered during processing are listed here together with their time of 
occurrence. They are also logged into a file named aws_error located in the subfolder 
data in the path “C:\ProgramData\Climsoft4”. 
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12. Paper Image Archiving 

Images of scanned paper records can be archived in Climsoft and later retrieved when required. 
The operation starts by first creating the metadata for the paper image archives then the folder 
where the image files will be archived. The archived image files may occupy large amount of 
storage space hence it is necessary to choose a folder where sufficient space is available. The 
folder may reside in the local server or in a network connected server or Network Attached 
Storage (NAS). Where the archiving is done on network folder it is recommended that it be 
mapped as a drive on the local server for convenience of accessing the image files. 

The procedures for creating paper archive metadata are as follows; 

From the Welcome form click on the icon Metadata Information then on the tab Paper Archive 
in the Metadata Information dialog and subsequently obtain the dialog shown in Figure 96. 

 
Figure 96: Dialog for creating paper archive metadata 

 Click AddNew button to clear the form and enter details of a new metadata record, 

 The metadata to be entered are the Form ID which is the identification allocated by the 
NMHS for that particular paper form. Details of the type of data contained in that form are 
entered in the Description box, 

 Click Save button to save the metadata record, 

 Other commands used are as follows; 
o Update – Saves changes made on a metadata record, 
o Delete – Removes a metadata record from the database if no image has been 

archived under that Form ID, 
o View – Displays all the metadata records in a tabular form. 
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It is required that the location (full path) for archiving the image files be configured in the general 
settings of Climsoft. Follow the steps below to achieve that; 

 From the main bar of Welcome dialog click Tools -> General Settings and browse the 
records until the “Setting Description“ box displays the value; “Folder for Paper 
Archive image files”. See Figure 97, 

 
Figure 97: General Setting Dialog 

 Type the full path of the folder to be used for the image files e.g. C:\PaperArchive\Images 
then click the Update button. If the path specified does not exist it will be created once 
the process of image archiving starts. When no folder has been setup archiving will still 
be possible but in a default folder that is in the path of the Climsoft installation. A message 
will be provided to that effect until the folder has been changed from the default. 

12.1 Archiving Images 

The filenames for the archived images are structured such that they describe the data 
contained in the image. Therefore, Climsoft maintains a standard filename structure for the 
archived image files. Image files having the standard filename structure are archived straight 
away while the others first required to be renamed before archiving. The following sections 
describe how images with different filename structures are archived. 

12.2 Archiving Images with Standard Filename Structure 

The Climsoft standard image filename is structured as; StnID-FormId-YYYYMMDDHH. The 
filename components are described as follows; 

 StnID – Station identification code for the station whose data is contained in that image, 

 FormId – Identification code for the paper form as described in the metadata, 

 YYYYMMDDHH – Date, time and other special descriptions for the image as follows; 
o YYYY=Year, MM=Month in 2 digits, DD = Day of the month in 2 digits, 
o If the image contains daily data for the whole month DD=Last day of that month, 

and HH=Hour for the daily observations e.g. 06, 
o If the image contains hourly or synoptic data for one day HH=00, 
o If one particular observation is contained in different pages hence different image 

files then HH will instead be used as page numbers in 2 digits starting with 01. 
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The procedure for archiving images with standard filename structure is as follows; 

(i) From the Welcome dialog, click on the icon Paper Archive to obtain the dialog shown 
in Figure 98, 

(ii) Click on the explorer button and select the folder containing images to be archived. All 
image files in that file will then be listed as shown in the dialog, 

(iii)  Uncheck the boxes for the image files that are not required. 
(iv) Click the command Archive to complete the process. 

           
Figure 98: Archiving images with standard filename structure   

12.3 Archiving Images without Standard Filename Structure 

From the Paper Archive dialog shown in Figure 98 click the tab “Unstructured Filenames” to 
obtain the dialog shown in Figure 99: 
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Figure 99: Dialog for archiving images with unstructured file names 

(i) Use the explorer button to select, open the image file and the image gets displayed as 
shown above. 

(ii)  Enter the details for the content of that image in their respective boxes in the dialog, 
(iii) The image may be rotated or zoomed so that the details are clearly seen. 
(iv) Click Archive to structure the filename and archive the image, 
(v) Repeat the process for all the images to be archived. 

12.4 Retrieving and Viewing Archived Images 

Through Climsoft, records of the archived images can be browsed, opened, updated or 
deleted. Images saved in pdf format can also be viewed but through a pdf reader. To perform 
these tasks follow the procedures below; 

From the Paper Archiving dialog click the tab “Retrieve Images” to obtain the dialog shown in 
Figure 100; 

(i) Browse through the records as desired, 
(ii) Edit the records where necessary and click “Update” to save the changes, 
(iii) Select the “View Image” to open or view the image for the current record. 
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Figure 100: Retrieved archived image 

12.5 Viewing a List of Archived Image Files  

To view the list of archived image files, click on the “Archival List” tab to open the dialog shown in 
Figure 101. Click on any image file from the list to have the archived image displayed. 

 
Figure 101: View the list of archived images 
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13. TDCF Synoptic data Encoding Operations 

13.1 Form for Synoptic data key entry and encoding 

Climsoft provides key entry form for synoptic observations. The form also facilitates encoding 
and sending the encoded messages to the message switch server for forward transmission to 
GTS. The structure of the form is shown in Figure 102. 

 

Figure 102: Synoptic Data for many elements for one observation time - TDCF Form 

Rules for entering data in the Synoptic forms with the aim of encoding into TDCF messages can 
be obtained from: WMO manual on codes, Code tables, TDCF Templates and Common tables. 
Data is then entered as follows: 

(i) Pressure Data – In Hpa and multiplied by 10 to remove the decimal point, 

They are: 

 Station Level Pressure (SLP) 

 Seal Level Pressure (MSL). To be entered as missing in stations above 500 M altitude and ; 

 Pressure Change (3Hr and 24Hr) – To be entered as missing when not observed 
(ii) Three (3) Hr pressure change characteristic - Code figure to be entered as described in the Manual on 

Codes.  

 Code figure 2 shall be used for positive tendency; 
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 Code figure 7 for negative tendency; and  

 Code figure 4 for no change  
(iii) Standard Pressure Level – In Hpa as a whole number and NOT multiplied by 10 e.g. 850 
(iv) Geopotential Height – In whole number of geopotential metres (gpm), 
(v) Temperatures – In degree Celcius and multiplied by 10 to remove the decimal point,  

They are: 

 Dry bulb - observed at synoptic hours, 

 Wet bulb - observed at synoptic hours, 

 Dew point - observed at synoptic hours, 

 Minimum - recorded at the hour for daily data observations e.g. 06Z, 

 Maximum – recorded daily but the hour varies with NMHS e.g. 18Z, 

 Grass minimum – recorded at the same hour with minimum temperature, 
(vi) Relative Humidity – In whole number of percentages, 
(vii) Visibility – In meters rounded into tens, 
(viii) Total Cloud Cover – Oktas. Climsoft will encode value into percentage of total cloud cover, 
(ix) Vertical Significance – Code figure for the appropriate vertical significance, 
(x) Low level Cloud Amount (Nh) – Code figure for the amount of lowest cloud level, 
(xi) Cloud Base Height (h) – Height in tens of metres for the base lowest cloud level, 
(xii) Low Level Cloud Type (CL) – Code figure for Low Level clouds type, 
(xiii) Medium Level Cloud Type (CM) – Code figure for Medium Level clouds type, 
(xiv) High Level Cloud Type (CH) - Code figure for High Level clouds type, 
(xv) Individual Cloud Layers – Vertical significance, amount, type and height of individual cloud layers that 

qualify to be considered should be entered in their appropriate boxes in the order they occur. When less 
than 4 layers are reported the remaining boxes should be left untouched or flag value M be used, 

(xvi) Present Weather, Past Weather (1) and (2) – Code figure for the appropriate weather description, 
(xvii) Evaporation – Kgm/M-2 multiplied by 10 to remove decimal point, 
(xviii) 24hr Sunshine – Number of hours multiplied by 10 to remove decimal point, 
(xix) 1Hr Sunshine – Number minutes in whole numbers, 
(xx) 3hr Rainfall – Amount accumulated for the last 3 hrs in Kgm/M-2 multiplied 10 to remove decimal point, 
(xxi) 24Hr Rainfall – Amount accumulated for the last 24hrs in Kgm/M-2 multiplied 10 to remove decimal point, 
(xxii) Wind Direction – Degree from True North in whole numbers, 
(xxiii) Wind Speed – M/S multiplied by 10 to remove decimal point, 
(xxiv) Radiation – MJ/M-2 multiplied by 100 to remove decimal point. 

13.2 TDCF Settings 

From Synoptic key entry form, click the button TDCF then the tab Settings to obtain the dialog shown below: 

 
Figure 103: TDCF Settings 
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The settings in the dialog shown in Figure 103 need to be in place before the encoding and 
sending of messages is done. To successfully configure Climsoft for this operation basic 
knowledge on WMO Table Driven Code Forms (TDCF) is required. Visit the WMO site for more 
details. The most useful reference documents are;  

(i) WMO manual on codes, 
(ii) Code tables, 
(iii) TDCF Templates and Common tables. 

On the dialog select the right encoding template from the list box Template and enter the 
message header according to the data type (T1T2A1A2ii) and originating center (CCCC). Enter 
the Message Switching System (AMSS) details where the messages will be routed to. Click 
Update to save changes in each case. 

13.3 Climsoft TDCF Encoding in BUFR 

When data entry for the synoptic hour is finished and TDCF settings as described in section 
13.2 done, click the button TDCF to obtain the TDCF processing dialog shown in Figure 104. 
Station and date for the current key entry record will then be displayed in their appropriate text 
boxes. Confirm whether that is the observation that is intended for encoding. If not then select 
the correct station and dates. Note that the encoded message will include data for all stations 

that have been observed on the same date and time.  

Click Encode button to encode the data into BUFR codes that will be displayed as shown in 
Figure 104. The encoded message binary file will be saved in the file shown in the text box 
“Encoded Message File”. 

Click Send button to send the binary file to message switching server for forward transmission 
to GTS. You can also view the content of your message from the text (csv) file by clicking the 
button View Descriptors. 

 
     Figure 104: TDCF Processing 
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14. Climsoft Versions Upgrade 
Whenever a new version of Climsoft is released, an upgrade setup file is provided to help 
users upgrade their earlier versions. This is different from setup file for new installation. The 
upgrade file is run on all client computers that already had Climsoft installed and is currently 
operational. 

The Climsoft installation and upgrade setup files can be downloaded from the link: 
https://www.met-elearning.org/course/view.php?id=58#section-2. An upgrade setup 
file looks like ClimsoftV422_upgrade.exe where V22 means it will upgrade the Climsoft 
installation to version 4.2.2.  

The following paragraphs describe how a Climsoft installation can be upgraded. 

14.1 Upgrading Climsoft Interface 

(i) Download the upgrade setup file and copy it in to a folder that can be easily located; 
(ii) Close any Climsoft session running in the client computer; 
(iii) Run the upgrade setup file as a Windows administrator to start the upgrade wizard as 

shown in Figure 105; 

 
Figure 105: Climsoft version upgrade  

(iv) Choose the language to be used in the wizard dialogs. The default language is English; 
(v) The wizard dialogs are very intuitive and easy to follow. Ensure that the path where 

Climsoft was installed is correctly selected e.g. C:\Program Files (x86)\ClimsoftV4; 
(vi) The final dialog will be as shown in Figure 106: 

 
Figure 106: Climsoft version upgrade  

(vii) Click Finish to complete the process. 

(viii) This process should be repeated in all Climsoft client desktops that have older versions. 

https://www.met-elearning.org/course/view.php?id=58#section-2
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14.2 Upgrading Climsoft Database 

Where the version upgrade involves changes in the database, an SQL script is included in setup 
file which requires to be run immediately after upgrading the interface. During the upgrade process 
the script file is copied into the “Dbase” folder of Climsoft installation path. The script file name is 
mariadb_climsoft_db_v4_all.sql. This script file is run to upgrade the database in the server as 
follows: 

(i) Start Climsoft from any client desktop after it has been successfully upgraded to the latest 
version. The version number is shown on the splash screen during the start process; 

(ii) From Welcome dialog click Tools => Update db with Script File as shown in Figure 106 

 

Figure 106: Climsoft version upgrade Menu 

(iii)  Select the script file and click Open as shown in Figure 107; 

 

Figure 107: Climsoft version upgrade script file opening 
  

(iv) Wait for the message “Finished updating the database”. Click Open to complete the 
process. 
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